Advanced Configuration Guide for Autodesk® data management server
Contents

Introduction......................................................................................................................................................... 1
Installing Autodesk data management server 2009 / 2010................................................................. 1
Customizing your Autodesk data management server 2009 / 2010 installation............................... 1
Installing Autodesk data management server 2009 / 2010 with other web applications using a different .Net version................................................................. 3
Installing the Autodesk data management server on a different web server port (2009) ........ 4
Install MS SQL Server prior to installing Autodesk data management server 2009 / 2010 .... 19
  Reconfiguring SQL Logins.......................................................................................................................... 20
Upgrading Autodesk data management server 2009 / 2010 to Full SQL Server ................................. 22
  Upgrading MS SQL 2005 to Full MS SQL 2008....................................................................................... 23
  Upgrading MS SQL 2005 Express to Full MS SQL 2005...................................................................... 26
  Upgrading MS SQL 2005 Express SP1 or higher to full MS SQL Server 2005 SP1 or higher........................... 30
Assigning SQL a custom TCP/IP Port .......................................................................................................... 32
Creating a Microsoft SQL Maintenance Plan............................................................................................. 34
Creating a Maintenance Script for Microsoft SQL Express 2005.............................................................. 44
Managing a remote file store....................................................................................................................... 45
  Moving the file store to a mapped drive or remote share................................................................. 46
    Create a new domain user account...................................................................................................... 46
    Create a remote share........................................................................................................................... 46
    Setting the new account in the Autodesk data management server Console............................... 46
    Moving the vault file store .................................................................................................................. 47
  Reconfigure IIS Worker Process and Application Pool ........................................................................... 48
Installing Autodesk data management server 2009 / 2010 on Microsoft Vista™....................................... 49
  Supported Vista Versions........................................................................................................................ 49
  Configuring Internet Information Services (IIS) 7.0.......................................................................... 49
  User Account Control............................................................................................................................... 50
Configuring automatic backups with Microsoft Vista™........................................................................... 51
Setting up a remote backup location........................................................................................................... 52
Configuring a remote Vault / (Productstream 2009) connection using FQDN........................................... 53
How to increase the timeout values on the Autodesk data management server server ................................ 53
Running Autodesk data management server with SSL............................................................................... 54
  Configuring the DM Server machine .................................................................................................... 54
  Configure the AutodeskDM Virtual Directory to require SSL Access.............................................. 55
  Configure IIS 7.0 with an SSL Certificate............................................................................................ 55
  Configuring Client Machines.................................................................................................................. 57
Solution 1 - Add the CA root certificate to the Trusted Root Certification Authority store on the client machine........................................................................................................57
Solution 2 - Check the expiration date of the certificate .................................................. 61
Solution 3 - Verify the certificate name matches the name of the site .............................. 61
Configuring a Client Computer with Internet Explorer 7 .............................................. 62
Login from client applications using SSL........................................................................ 63
Using Vault with a Proxy Server ...................................................................................... 64
Change the proxy settings in Internet Explorer 6.x, 7.x .................................................. 64
Configure the proxy server to use a host name ............................................................... 64
Bypassing a Proxy Server with the Application config file............................................ 65
Autodesk data management server Log Files .................................................................. 66
Autodesk data management server 2009 / 2010 installation log files .......................... 66
Autodesk Server Diagnostic Tool Log files................................................................. 67
Microsoft SQL Server log files...................................................................................... 67
DWG and DWF iFilter Log files .................................................................................... 68
Indexing Block Attributes (DWG files) ........................................................................ 68
Customize W3C Extended Logging .............................................................................. 69
Productstream 2009 / Vault Manufacturing 2010 Replication ...................................... 72
Scalability of Replication .............................................................................................. 72
Content Center in a Replicated Environment ................................................................ 73
Private Content Center Folder ...................................................................................... 73
Seeding the Content Center Folders ............................................................................ 75
Revision History ............................................................................................................ 76
Introduction
The Advanced Configuration Guide contains additional information for setting up the Autodesk® data management server 2009 and 2010. The topics in this guide relate to the Autodesk® data management server and can be used for Autodesk® Vault 2009, Autodesk® Productstream 2009 and all versions of Vault 2010 unless otherwise noted in the instructions for each configuration. As these topics cover advanced configurations, some familiarity with IT procedures is assumed. For more information, refer to the Autodesk® data management server implementation and Managing Your Data guides.

Installing Autodesk data management server 2009 / 2010
For standard installation configurations, consult the Autodesk data management server 2009 Implementation and Managing Your Data guides.

Customizing your Autodesk data management server 2009 / 2010 installation
To customize your installation perform the following:

1. When you get to the Review – Configure – Install section in the Installation wizard, select the Configure button next to the product drop-down list.

![Select a product to configure: Autodesk Vault 2010 (Server) Configure]

Current settings:

2. In the next screen, select the Autodesk data management server 2009 (2010) tab. Here you will have the option to change the destination folder for the Autodesk data management server application, as well as SQL databases and Microsoft SQL program files.

![Autodesk Vault 2010 (Server) Content Center Libraries for Inventor...]

Select the Installation Type

- [ ] Local database
- [ ] Remote database

Specify location of SQL installation folder:

```
C:\Program Files\Microsoft SQL Server\
```

Specify location of SQL database:

```
C:\Program Files\Microsoft SQL Server\
```

Specify location of server application:

```
C:\Program Files\Autodesk\ADMS 2010\
```
3. You will also have the option to set the SQL SA password during installation by checking the box next to Use my SQL credentials.

4. Vault Server 2010 has the option to automatically configure IIS to a port other than the default port, 80.

5. Select the Configuration Complete button in the lower right corner of the dialog to return to the Review – Configure – Install dialog. This will then show you the current settings that will be used during the installation. Confirm your custom settings and select Install to start the installation.
Installing Autodesk data management server 2009 / 2010 with other web applications using a different .Net version

The Autodesk data management software will usually coexist with other web applications in the Default Web Site of IIS. However, there are certain applications that require a different .Net Framework version. This section illustrates how you can configure the Autodesk data management server Virtual directory to run under a different .Net version in the Default Application pool. You cannot run two different versions of .NET Framework in the same application pool with IIS 6.0. To work around this limitation, you will need to create a second application pool, and then configure it to run .NET Framework 2.0. Prior to running the Autodesk data management server installation you will have to configure the Default Web Site to use .Net 2.0.

**Note:** Changing this setting will disable all other virtual folders under the Default Web Site to use .Net 2.0 until you change it back to the required .Net version for that application.

**Open the IIS management console.**
1. Open each virtual directory and note the .NET version that it is configured to use.
2. Right-click the Default Web Site and select Properties.
3. On the ASP.NET tab, select the .NET 2.0.50727 from the drop-down list and click OK.

**To create an Application Pool**
1. Open “Internet Information Services (IIS) Manager” in the “Administrative Tools” of the “Control Panel”.
2. Right-click the “Application Pools” folder. Click “New Application Pool”.
3. In the “Application pool ID” field, enter “AutodeskAppPL”.
4. Select the “Use existing application pool” as template radio button and use the “DefaultAppPool” as a template.
5. Click the OK button to apply the changes.

**To assign the new Application Pool**
1. Expand the “Default Web Site” and navigate to the “AutodeskDM\Services” virtual directory.
2. Right-click on the “Services” directory and select “Properties”.
4. “Apply” the changes and close the properties of the Services virtual directory.

**To reset the .NET Framework version**
1. Open the properties of the “Default Web Site”.
2. In the ASP.NET tab, select the original .Net version from the drop-down list. **Note:** If you are changing this from .NET 2.0 to a different version you will have to reconfigure the AutodeskDM\Services virtual directory back to .NET 2.0.
3. Re-check all Virtual directories to make sure the correct .NET version is configured for the application.
Installing the Autodesk data management server on a different web server port (2009)

The Autodesk data management software will usually coexist with other web applications in the Default Web Site of IIS. However, there are certain applications that require exclusive access to the website, different .Net Framework or different security settings. These instructions illustrate how to install the Autodesk data management server software on another port and site to avoid conflicts. This procedure can only be done on Windows 2003 and Windows 2008 and Autodesk data management server 2009.

For Windows 2003

1. Open Internet Information Services Manager from Control Panel -> Administrative Tools.
2. Expand the local computer name.
4. In the Add New Application Pool dialog type AutodeskAppPl in the Application pool Id field.
5. Click the OK button to close the Add New Application Pool dialog box.
6. Expand the Web Sites folder and right-click on the Default Web Site and select Properties.
7. Temporarily change the existing default web site to run on a different port, for example 8080. If you have other application that are running on port 80 you will have to temporarily change the port number those as well.

8. Right-click the Web Sites folder and then select New Web Site to create a new web site.

9. This wizard helps you create a new web site for Autodesk DM Products.
10. Type Autodesk Vault in the Description field.

11. By default, the Autodesk data management server installation looks for the site on port 80. Use the default settings in the IP address and Port Settings dialog.

Use default of 80, we will switch it later.
12. The actual directory for this website is not important. You should create a temporary folder and set the Path field to this location.

![Web Site Creation Wizard](image)

Use any blank directory that works for you

13. Use the following options in the Web Site Access Permissions dialog box.

![Web Site Access Permissions](image)

14. Click Next and then click Finish to complete the creation of the new web site.
15. Right click on the web site you just created and select Properties.


17. Open the ASP tab and select 2.0.50727 from the ASP.NET version drop-down list.
18. Use Notepad or another text editor to create a simple HTML (HyperText Markup Language) file. It is necessary to create a file on the new website to pass some of the pre-checks on the Autodesk data management server installer.

```
<html>
<body>
This is a test of the new website for vault
</body>
</html>
```

19. Make sure that the new website works by opening Internet Explorer and typing http://localhost in the Address field.

```
http://localhost/index.htm - Microsoft Internet Explorer
```

20. Start the Autodesk data management server installation and correct any errors reported by the pre-checks.

21. After the installation is complete, log into the vault from a client workstation and start the Autodesk data management server Console to verify that it is working properly.

22. After you have confirmed everything is working properly, close the Autodesk data management server Console and log the client workstation out of vault.
23. Go back to the IIS Manager and choose Properties for the new web site.

24. Change the TCP port to an unused port number. Port 8081 is often available.

25. Open Windows Explorer and navigate to the `<install dir>`\Autodesk\Data Management Server 2009\Autodesk data management server Console directory.


28. Find the following line: `<add key="PORT" value="80" />`. Change this value to the port number that you set up for the vault web site. Save and close the file.

29. In Windows Explorer, navigate to the `<install dir>`\Autodesk\Data Management Server 2009\Server\Web\Services directory.


31. Open the web.config file with Notepad.

32. Find the following line: `<server port="80" ssiRequired="false" />`. Change this value to the port number that you setup for the vault web site. Save and close the file.

33. In Windows Explorer, navigate to the `<install dir>`\Autodesk\Data Management Server 2009\Server\Dispatch directory.


36. Find the following line: `<add key="Server" values="127.0.0.1" />`. Change this value to “127.0.0.1:port number”. Save and close the file.

37. Stop the Autodesk Vault website and then restart it.

38. Open the Services icon in the Administrative Tools of the Control Panel.
39. Find the Autodesk data management Job Dispatch service and Restart the services.

40. Users accessing the vault need to add the new port number to the server name field with the following format: Hostname:portnumber.

41. Open the properties of the original Default Web Site. Set the TCP Port back to 80 and then stop and restart the web site. You will have to perform this step on any other web application that was also previously set to port 80.

**Note:** Hot fixes may not install properly when using this custom configuration. You may have to temporarily change the port back to 80 to apply the desired hotfix.

**For Windows 2008**

1. Open Internet Information Services Manager from Control Panel -> Administrative Tools.
2. Expand the local computer name.
3. Expand the Sites Folder and right click on the Default Web Site and select Edit Bindings.

4. Highlight the entry for HTTP and click the Edit button.
5. Temporarily change the existing default web site to listen on a different port, for example 8080. If you have other applications that are listening on port 80, you will have to temporarily change the port number on those as well.

6. Right click the Sites folder and then select Add Web Site to create a new web site.
7. Type AutodeskVault as the site name and enter any temporary directory for its physical path. Use the default setting of 80 for the port setting.

8. Use Notepad or another text editor to create a simple html file. It is necessary to create a file on the new website to pass some of the pre-checks on the Autodesk data management Server installer.

```html
<html>
<body>
This is a test of the new website for vault
</body>
</html>
```
9. Make sure that the new website works by opening Internet Explorer and typing http://localhost in the Address field.

   ![Internet Explorer](http://localhost/index.htm - Microsoft Internet Explorer)

   This is a test of the new website for vault

10. Start the Autodesk data management server installation and correct any errors reported by the pre-checks.

11. After the installation is complete, log into the vault from a client workstation and start the Autodesk data management server Console to verify that it is working properly.

12. After you have confirmed everything is working properly, close the Autodesk data management server Console and log the client workstation out of vault.

13. Go back to IIS Manager, right click on the new web site you created and select Edit Bindings.

   ![IIS Manager](image)

14. Select the current binding and click on Edit.
15. Change the port to an unused port number. Port 8081 is often available.

16. Open Windows Explorer and navigate to the `<install dir>\Autodesk\Data Management Server 2009\Autodesk data management server Console directory.


19. Find the following line: `<add key="PORT" value="80" />`. Change this value to the port number that you set up for the vault web site. Save and close the file.

20. In Windows Explorer, navigate to the `<install dir>\Autodesk\Data Management Server 2009\Server\Web\Services directory.


22. Open the web.config file with Notepad.

23. Find the following line: `<server port="80" sslRequired="false" />`. Change this value to the port number that you setup for the vault web site. Save and close the file.

24. In Windows Explorer, navigate to the `<install dir>\Autodesk\Data Management Server 2009\Server\Dispatch directory.


27. Find the following line: `<add key="Server" values="127.0.0.1" />`. Change this value to "127.0.0.1:port number". Save and close the file.
28. Stop the Autodesk Vault website and then restart it.

29. Open the Services icon in the Administrative Tools of the Control Panel.

30. Find the Autodesk data management Job Dispatch service and Restart the services.
31. Users accessing the vault need to add the new port number to the server name field with the following format: Hostname:portnumber.

![Login dialog box](image)

32. Open the properties of the original Default Web Site. Set the TCP Port back to 80 and then stop and restart the web site. You will have to perform this step on any other web application that was also previously set to port 80.

**Note:** Hot fixes may not install properly when using this custom configuration. You may have to temporarily change the port back to 80 to apply the desired hotfix.
Install MS SQL Server prior to installing Autodesk data management server 2009 / 2010


Note: This installation process may require the server to reboot multiple times. Please be sure you are able to perform the necessary reboots. Also, if you use a custom password for the SQL SA account, you will need to specify this password during the installation of the Autodesk data management server. Please see the Customizing your Autodesk data management server 2009 Installation section in this document.

Use the following steps for Microsoft SQL 2005:

1. Start the installation process for Microsoft SQL 2005 Server.
2. The installation process installs any necessary prerequisites and begins running the pre-installation checks. Note any errors and take the necessary corrective actions before continuing.
3. In the Components to Install dialog, select SQL Server Database Services. To modify the installation path, click Advanced.
   a. In the Feature Selection dialog, you can expand the Database Services options and change the location of the data files directory.
4. In the Instance Name dialog, enter the name of the instances as "AutodeskVault".
   Note: If you install SQL without using this instance name, the AUTODESK DATA MANAGEMENT SERVER installation will create its own instance of SQL Server called AutodeskVault using Microsoft SQL Express 2005.
5. In the Service Account dialog, specify the Local System account or if you plan on performing backups and restores to remote locations, specify a Domain User account for the SQL Server.
6. In the Authentication Mode dialog, select Mixed Mode authentication and set the SA password. The default password used during a default installation for the SA password is "AutodeskVault@26200".
   Note: If you use a different SA password, you will need to use the "use my SA Credentials" option in the Customizing your Autodesk data management server 2009 Installation section in this document.
7. Download and install the latest SQL 2005 service packs (SP2 only) and hot fixes from Microsoft’s web site.
Use the following steps for installing Microsoft SQL 2008:

1. Start the installation process for Microsoft SQL 2008 Server.

2. The installation process installs any necessary prerequisites and begins running the pre-installation checks. Note any errors and take the necessary corrective actions before continuing.

3. In the SQL Server Installation Center, select New SQL Server stand-alone installation or add features to an existing installation.

4. In the Feature Selection window, select Database Engine Services.

5. In the Instance Configuration window, select Named instance and enter the name as "AutodeskVault".

   **Note:** If you install SQL without using this instance name, the Autodesk data management server installation will create its own instance of SQL Server called **AutodeskVault** using Microsoft SQL Express 2005.

6. In the Server Configuration window, select the Service Accounts tab.
   a. Specify the NT AUTHORITY\NETWORK SERVICE account for the SQL Server Database Engine. You can leave the password blank. If you plan on performing backups and restores to remote locations, specify a Domain User account.
   b. Set the Startup Type to Automatic.

7. In the Database Engine Configuration window, select the Account Provisioning tab.
   a. Select **Mixed Mode** authentication and set the SA password. The default password used during a default installation for the SA password is "AutodeskVault@26200".

   **Note:** If you use a different SA password, you will need to use the “use my SA Credentials” option in the Customizing your Autodesk data management server 2009 Installation section in this document.

8. Download and install the latest SQL 2008 service packs and hot fixes from Microsoft’s web site.

---

**Reconfiguring SQL Logins**

If you don’t have a domain password policy, you can skip this section. If your domain has a password policy configured, you must use a password that complies with the policy. After the installation is complete, reset the sa password to “AutodeskVault@26200” and uncheck the Enforce password policy check box. It is also necessary to create a SQL login account named VaultSys. To create this account:

1. Open the Microsoft SQL Server Management Studio.

2. Expand the Security\Logins folder.

3. Right-click on the Logins folder and select New Login.

4. Type “VaultSys” for the login name.

5. Select SQL Server Authentication.

6. Type “SuperMan769400006!” for the password.
7. Uncheck the box for Enforce password policy.

8. Select the Server Roles page.

9. Check the boxes next to the following roles:
   - dbcreator
   - processadmin
   - setupadmin

10. Click OK to create the account.
Upgrading Autodesk data management server 2009 / 2010 to Full SQL Server

When upgrading to the full version of Microsoft SQL Server, it is assumed the appropriate IT and engineering staff required to allow access to the server and client systems, as well as to allow periodic system restarts are available. It is also recommended that you perform the upgrade in a test environment prior to performing the upgrade on the production environment. The client side systems are needed to verify that the upgrade has been performed successfully.

The server upgrade can be performed at any time after Autodesk data management server has been installed. The server may need to be rebooted one or two times during the upgrade process.

During the upgrade, the SQL server instance and the Autodesk Vault Server Services are shut down. Anyone logged into the vault at the time is automatically disconnected. Make sure all users are logged out of the Autodesk data management server. The upgrade will not affect the state of checked out files, nor will it modify the database structure, state of the files, or parent child relationships.

Before upgrading the SQL server, perform a backup from the Autodesk data management server Console application. For more information on backing up data, see the Autodesk data management server Console Help.
Upgrading MS SQL 2005 to Full MS SQL 2008

Microsoft does not support migrating directory from MS SQL 2005 Express to MS SQL 2008 Standard or Enterprise. Potential migration paths include upgrading from MS SQL 2005 Express to MS SQL 2005 Full to MS SQL 2008 Full, and MS SQL 2005 to MS SQL 2008 Express to MS SQL 2008 Full. **Please note that MS SQL 2008 Express is NOT a supported database engine for Autodesk data management server.** Additional migration paths can be found here: [http://msdn.microsoft.com/en-us/library/ms143393.aspx](http://msdn.microsoft.com/en-us/library/ms143393.aspx) Also note that SQL 2008 may require several restarts to complete installation.

Upgrading from SQL 2005 Express to Full SQL 2008

1. Download SQL 2008 Express from [http://www.microsoft.com](http://www.microsoft.com) or insert your SQL 2008 Express installation media. Please note that you may be required to install Windows Installer 4.5 prior to SQL 2008 Express (KB942288).

2. Select the “Installation” option and begin the “Upgrade from SQL server 2000 or SQL Server 2005” Wizard.

3. Continue through the pre-installation process. Pre-request files and services will be updated. Setup Support Rules will be processed.

4. Select the AutodeskVault instance to upgrade, confirm instance settings.

   Select the instance of SQL Server to upgrade. To upgrade only Management Tools and shared features, select “Upgrade shared features” and then click next.

   Instance to upgrade: **AUTODESKVAULT**

<table>
<thead>
<tr>
<th>Instance Name</th>
<th>Features</th>
<th>Version</th>
<th>Edition</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTODESKVAULT</td>
<td>SQLEngine,SQLEngine\Replication,SQLEngine\SharedTools</td>
<td>9.2.3042.00</td>
<td>Express</td>
</tr>
</tbody>
</table>

5. Continue through Disk Space requirements, Upgrade rules, and Upgrade Process. Setup will complete and upgrade the AutodeskVault SQL instance to SQL 2008 Express.

   Information about the Setup operation or possible next steps:

   ![Your SQL Server 2008 upgrade completed successfully.](image)

7. Verify version and or product key for Full SQL 2008 and proceed to the Select Instance window and choose the AutodeskVault instance.

8. Upgrade the Instance. Once the instance has been upgraded, you can install the SQL Management Studio by returning to the "Installation" option and being the "New SQL Server stand-alone installation or add features to an existing installation" wizard.

Upgrading from Full SQL 2005 to Full SQL 2008

1. Select the "Installation" option and begin the "Upgrade from SQL server 2000 or SQL Server 2005" Wizard.

2. Continue through the pre-installation process. Pre-request files and services will be updated. Setup Support Rules will be processed.
3. Select the AutodeskVault instance to upgrade, confirm instance settings.

   Select the instance of SQL Server to upgrade. To upgrade only Management Tools and shared features, select "Upgrade shared features" and then click next.

   **Instance to upgrade:** AUTODESKVAULT

   **Installed instances:**

<table>
<thead>
<tr>
<th>Instance Name</th>
<th>Features</th>
<th>Version</th>
<th>Edition</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTODESKVAULT</td>
<td>SQL Engine, SQL Engine\Replication, SQL Engine\Full-Text, SQL Engine...</td>
<td>9.00.1395.06</td>
<td>Standard</td>
</tr>
</tbody>
</table>

4. Please note, if you do not see the "Database Engine Services" listed as a component to be migrated, you are not following an accepted migration path.

5. Continue through Disk Space requirements, Upgrade rules, and Upgrade Process. Setup will complete and upgrade the AutodeskVault SQL instance to Full SQL 2008.

   Information about the Setup operation or possible next steps:

   - Your SQL Server 2008 upgrade completed successfully.
Upgrading MS SQL 2005 Express to Full MS SQL 2005

6. Insert your MS SQL 2005 installation disc into the drive and start the installation wizard. It installs the required pre-requisites first then begins the installation process.

7. Click Next. The wizard performs a system configuration check. Verify that all checks have a status of Success and then click Next.
8. In the Components to Install dialog, check the SQL Server Database Services and then click Next.

![Components to Install dialog](image1.png)

9. In the Instance Name dialog, select the Named instance radio button and type AutodeskVault or you can select the Installed instances button and select the AutodeskVault instance and then click Next.

![Instance Name dialog](image2.png)
10. The Existing components dialog lists the SQL Server Database Services that are going to upgrade. Check the box next to the SQL Server Database and then click Next.

11. The Upgrade Logon Information dialog prompts you for an account that will be used to perform the upgrade. You should be logged in with an account that has local Administrative privileges on the server. Select the Windows Authentication Mode and then click Next.
12. In the Service Account dialog, select either a built-in System account or a domain user account to run the SQL Browser. Click Next.

**Note:** If you were previously using a user account to run the SQL Server Service, select Use a domain user account radio button and fill in the required fields with that account.

13. The Error and Usage Report Settings dialog displays optional settings that are not required by Autodesk.
14. On the Ready to Install dialog, click Install to begin the upgrade process.

![Microsoft SQL Server 2005 Setup]

On the Ready to Install dialog, click Install to begin the upgrade process.

The following components will be installed:

- SQL Server Database Services (Upgrade)
  (Database Services, Replication, Full-Text Search)

15. Download and install MS SQL 2005 Service Pack 2 from Microsoft’s web site, if needed.

**Note:** For optimum performance, create a SQL Maintenance Plan after performing this upgrade. Follow the steps in the Creating a SQL Maintenance Plan section.

**Upgrading MS SQL 2005 Express SP1 or higher to full MS SQL Server 2005 SP1 or higher.**

To upgrade a SQL Express 2005 SP1 installation to a full version of SQL 2005, using a disc which doesn’t include a service pack, SP1 or higher, you can use 1 of the following methods:

**Note:** An Autodesk data management server Console backup is recommend prior to performing either of these methods.

**Method 1**

1. Open a command prompt and navigate to the directory where the full version of SQL setup is located.
2. Type “setup.exe SKUUPGRADE=1” (this is case sensitive).
3. Start the upgrade and select the AutodeskVault instance.
4. After the upgrade is complete, apply the latest SQL service pack since this upgrade actually doesn’t have on and it isn’t transferred from SQL Express.

**Method 2**
1. Create a full backup of your vault using the Autodesk data management server Console.

   **Note:** In later steps you will be deleting all of your vault databases. You should validate that this backup is able to be restored on a test server before proceeding. **Do not continue if your test restore fails.** Correct any problems you have with the backup prior to continuing these steps.

2. After the test restore is successful, open the Autodesk data management server Console and delete all vaults and libraries listed. Then select Detach Master Vault from the Tools menu.

3. Make sure all users are logged out of the vault.

4. Completely uninstall SQL 2005 Express. This includes the following applications in this order:
   a. Microsoft SQL Server 2005
      **Note:** If you have more than one instance of SQL Express installed, be sure to only uninstall the AutodeskVault instance and DO NOT uninstall any other part of SQL after this step is complete.
   b. MS SQL Server Native Client
   c. MS SQL Server VSS Writer
   d. MS SQL Server 2005 Backward Compatibility
   e. MS SQL Server Setup Support Files

5. Delete the SQL Express folders from Program Files (including data files). If your Vault databases are located on a different drive, be sure to delete the files in this location as well.

6. Install the full version of SQL 2005 with an AUTODESKVAULT instance as in the “Install MS SQL Server Prior to Installing Autodesk data management server” section.


8. Restore the backup that you created in step 1 using Autodesk data management server Console.

If you have any difficulty removing the MS SQL Express instance, refer to Microsoft Knowledgebase article 909967 to help manually remove this instance.

**Note:** For optimum performance, create a SQL Maintenance Plan after performing this upgrade. Follow the steps in the Creating a SQL Maintenance Plan section.
Assigning SQL a custom TCP/IP Port

This section outlines the steps to set SQL to a non-standard TCP/IP port.

SQL Server 2005

1. Install full SQL Server 2005 as per the Advanced Configuration Guide.
2. On the server where SQL is installed, start the SQL Server Configuration Manager.
3. In the SQL Server Configuration Manager dialog, expand the SQL Server 2005 Network Configuration and select Protocols for AUTODESKVAULT.
4. In the right pane double-click on the TCP/IP protocol to open its properties.
5. In the TCP/IP Properties dialog, select the Protocol tab and change the Enabled property to Yes.

6. Select the IP Addresses tab.
7. Scroll down to the bottom of the dialog until you get to the IPAll section.
8. Change the TCP Port field to the port you desire.
9. Apply your changes and select OK to close the TCP/IP Properties dialog.
10. In the SQL Server Configuration Manager dialog, select the SQL Service 2005 Services section in the left pane.
11. Select SQL Server (Autodesk Vault) in the right-pane, right-click on it and select Restart.

**Autodesk data management server**

1. Select Start -> Run and type cliconfig and the SQL Server Client Network Utility dialog should open.
2. In the SQL Server Client Network Utility dialog, select the Alias tab.
3. In the Alias tab, select the Add button.
5. In the Server alias box type the name of the server where SQL is installed along with the instance name.
6. Uncheck the Dynamically determine port and enter the port number you configured in step 8 above.

![Edit Network Library Configuration](image)

7. Click the OK button to apply the settings.
8. Start your Autodesk data management server installation.
Creating a Microsoft SQL Maintenance Plan

Maintenance plans can be used to schedule maintenance tasks required to make sure that the database performs well, such as keeping database and transaction log file size small and checking the database for inconsistencies.

1. Verify that the vaults have been backed up with the Autodesk data management server Console before proceeding.
2. Make sure that all users are logged out of the vault server.
3. From the Control Panel, double-click Administrative Tools and then double-click the Services icon.
4. Locate the SQL Server Agent (AUTODESKVAULT) service.
5. Right-click on the SQL Server Agent (AUTODESKVAULT) and select Properties.
6. Change the Startup Type to Automatic and start the service.
7. Open the Microsoft SQL Server Management Studio and connect to the AutodeskVault Instance. Use `<computername>\AutodeskVault` as the server name and press Connect.

8. Right-click on the Vault database and select properties.
9. On the Files Page, set the Autogrowth property for the Vault databases to 100 Megabytes. For custom libraries set this to 25 Megabytes.

**Note:** Do not change the size of the log files and the KnowledgeVaultMaster database and log files. Also make sure that you have MS SQL 2005 SP2 installed before changing this setting.

![Database files](image)

10. On the Options page, change the Recovery Model to Simple, Compatibility Level to SQL Server 2005 (90) (Set to SQL SERVER 2008 (100) for SQL 2008) and change
11. Perform these same steps for all of the Vault and library databases.
12. Expand the Management folder and select the Maintenance Plan folder.
13. Right-click on the Maintenance Plan folder and select Maintenance Plan Wizard, hit next if the following dialog appears.

14. In the Select Plan Properties dialog, enter Vault Maintenance Plan for the name and then click on the Change button to set the schedule.

15. In the Job Schedule Properties dialog, set the plan to run after an Autodesk data management server Console backup has been completed. Depending on the size of your databases, this schedule may have to be run on a different day and time of the week. You may want to run this task on a Saturday to determine the amount of time it will take to complete and then decide the best day and time to run this job on a
regular basis.

16. In the Select Maintenance Task dialog, check the following options:
17. In the Select Maintenance Task Order dialog, set the order to the following:

- Check Database Integrity
- Shrink Database
- Reorganize Index
- Rebuild Index
- Update Statistics
- Clean Up History
- Execute SQL Server Agent Job
- Back Up Database (Full)
- Back Up Database (Differential)
- Back Up Database (Transaction Log)
- Maintenance Cleanup Task

The History Cleanup task deletes historical data about Backup and Restore, SQL Server Agent, and Maintenance Plan operations. This wizard allows you to specify the type and age of the data to be deleted.

18. In the Define Database Check Integrity Task dialog, select All user databases from the databases drop-down list and check the box next to Include Indexes.
19. In the Define Rebuild Index Task dialog, select All user databases from the Databases drop-down list.

20. In the Define Reorganize Index Task dialog, select the All user databases from the Databases drop-down list.
21. In the Define Shrink Database Task dialog, select All user databases from the Databases drop-down list.

22. In the Define Update Statistics Task dialog, select the following options.
23. In the Define Cleanup History Task dialog, select cleanup options as needed.

![Define History Cleanup Task](image)

24. In the Select Report Options dialog, specify the location for the maintenance reports.

25. Click Next and then Finish.
Creating a Maintenance Script for Microsoft SQL Express 2005

Microsoft SQL Express 2005 doesn’t allow you to create a maintenance plan inside of SQL Server Management Studio Express. This script will perform a Shrink, Re-index, a change of the Recovery Model to Simple, change the Autogrowth value to 100 Megabytes and Update Statistics on the database.

Copy the script below and create a file named VaultMaintenance.bat. The batch file requires the name of the vault as a command line parameter.

**Note:** It is recommended that you have MS SQL Express 2005 SP2 installed. You will need to run this script for the KnowledgeVaultMaster and Vault databases that has been created.

The following is an example of how to run the batch file and output the results to a text file. **Note:** A direct copy-paste from this PDF will require the linebreaks be repaired.

```
C:\VaultMaintenance.bat vault > results.txt
```

```batch
@echo off
if "%1"=="" goto NOPARAM
set VAULTNAME=%1

@echo Setting database recovery model to simple...
osql -E -S ".\AutodeskVault" -Q "ALTER DATABASE %VAULTNAME% SET RECOVERY SIMPLE"

@echo Setting database Autogrowth value...
osql -E -S ".\AutodeskVault" -Q "ALTER DATABASE %VAULTNAME% MODIFY FILE (NAME=%VAULTNAME%, FILEGROWTH=100MB)"

@echo Shrinking %1 database...
osql -E -S ".\AutodeskVault" -Q "USE %VAULTNAME% DBCC SHRINKDATABASE(%VAULTNAME%, 10)"

@echo Reindexing %1 database...
osql -E -S ".\AutodeskVault" -Q "USE %VAULTNAME% DECLARE tableCursor CURSOR FOR SELECT NAME FROM sysobjects WHERE xtype in('U') DECLARE @tableName nvarchar(128) OPEN tableCursor FETCH NEXT FROM tableCursor INTO @tableName WHILE @@FETCH_STATUS = 0 BEGIN DBCC DBREINDEX(@tableName, '') FETCH NEXT FROM tableCursor INTO @tableName END CLOSE tableCursor DEALLOCATE tableCursor"

@echo Updating statistics on %1 database...
osql -E -S ".\AutodeskVault" -Q "EXEC sp_updatestats"

goto EXIT

:NOPARAM
echo [FAIL] Please indicate Vault database
pause
:EXIT
```
Managing a remote file store

To move the location of your file store to a mapped drive or remote shared location:
The vault supports two basic file store configurations:

1. File store located on the Autodesk data management server.

2. File store located on a remote file server that has a shared folder.

A remote file server can be used for hosting the file store and/or backing up and restoring vault data. This section describes the steps required to configure a remote file store.
Moving the file store to a mapped drive or remote share

For simplicity purposes, the computer hosting Autodesk data management server is called **DMMachine** and the computer hosting the remote file store is called **FSMachine**. The domain name is **MyDomain**. We are also assuming that the server where Autodesk data management server is installed is a member server and not a domain controller.

If you have the Autodesk data management server installed on a domain control, the AutodeskVault domain account is used and you can go the Moving the File Store section below.

**Create a new domain user account.**

1. Open the Active Directory Users and Computers and select an Organizational Unit (OU) to create the account in.
2. Create an account named AutodeskRemote. Set the password to match your domain password policy and set the password to never expire.

**Create a remote share.**

1. Open Windows Explorer on the FSMachine and create a directory called VaultData.
2. Right-click on the folder and select Properties.
3. Go to the Sharing tab and create a new share named VaultData.
4. Click Permissions and set the AutodeskRemote, Network Service, and System user to Full Control.
5. Click OK in the Permissions for Share dialog box.
6. Go to the Security tab and add the AutodeskRemote account and set it to Full Control permission.

**Setting the new account in the Autodesk data management server Console**

1. On the DMMachine, open the Autodesk data management server Console.
2. From the File menu, select Stop Web Service.
3. Select Tools > Administration.
4. In the Advanced Settings tab select the Settings button next to Advanced Configuration settings.
5. In the Advanced Settings dialog, change the User Name to MyDomain\AutodeskRemote and type in the selected password.

```
Advanced Settings

Impersonation
User Name: MyDomain\AutodeskRemote
Password: **************

Connection
Connection Timeout: 1000 Seconds

Share Path
Current Path:
New Path: ...

Log File Configuration
Limit the number of log files before they are recycled. Value must be between 6 and 99.
- Maximum number of console logs: 5
- Maximum number of server logs: 6

Reset Defaults
```

6. Apply the changes and then click OK.

**Moving the vault file store**

1. Select the vault which you would like to move to a different location.
2. Select Actions > Move File Store.
3. Set the New File Store Location field to \FSMachine\VaultData.
4. Click OK.
Reconfigure IIS Worker Process and Application Pool

The following steps are for IIS 6.0.

1. Open the Active Directory Users and Computers and select an Organizational Unit (OU) to create the account in.

2. Create an account named AutodeskID. Set the password to match your domain password policy.

3. Make the AutodeskID account a member of the IIS_WPG local group on DMMachine.

4. Give AutodeskID account Full Control permissions to the %SystemRoot%\Temp directory on DMMachine.

5. Give the AutodeskID account Full Control permissions to the \FSMACHINE\VaultData remote file store directory.

6. Open Internet Information Services (IIS) Manager and create a new Application Pool named AutodeskAppPL.

7. Open the properties of the AutodeskAppPL Application Pool and go to the Identity tab.

8. Add the domain account AutodeskID, set the password and apply the changes.

9. Expand the Default Web Site and navigate to the AutodeskDM\Services virtual directory.

10. Right-click on the Services directory and go to the Directory tab.

11. Change the Application Pool pull-down to the newly created AutodeskAppPL Application Pool.

12. Apply the changes and close the properties of the Default Web site.

13. Close the IIS Manager.

14. Open a Command prompt and type IISRESET.

15. Add new files to the vault and verify that the properties are able to be indexed.
Installing Autodesk data management server 2009 / 2010 on Microsoft Vista™

Yes, you can install Autodesk data management server on a computer running Windows Vista™. However, you will need to configure some Vista™ system settings before you install Autodesk data management server.

Supported Vista Versions

The following chart shows the versions of Vista that Autodesk data management server is support inside of IIS and which are supported with the Autodesk Web Server (AWS).

<table>
<thead>
<tr>
<th>Operating System</th>
<th>AWS</th>
<th>IIS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Vista™ Ultimate</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Microsoft Vista™ Enterprise</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Microsoft Vista™ Business</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Microsoft Vista™ Home Premium</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Microsoft Vista™ Home Basic</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

Note: Vault Collaboration, Vault Workgroup, and Vault Manufacturing do NOT support AWS. You must use IIS. Base Vault Server 2010 does support AWS.

Note: IIS 7.0 has a limit of 10 simultaneous requests on Vista™ Ultimate, Enterprise, Business, and Home Premium editions. When the connection limit is reached, the request is queued until the number of currently processing requests drops below the limit. IIS then will take the first request in the queue and starts to process it. Previous versions of IIS would return an “Error 403.9 Access Forbidden – Too many users are connected”.

Configuring Internet Information Services (IIS) 7.0

If you will be using Microsoft® Internet Information Services (IIS) 7.0 with Autodesk data management server, IIS 7.0 must be configured before you install Autodesk data management server. IIS 7.0 can be installed by the Autodesk data management server 2009 / 2010 installation process. If you are installing IIS 7.0 manually, follow the steps below to configure the system options:

1. From the Windows Start menu select “Settings” > “Control Panel”.
2. In the Control Panel, double-click “Programs and Features”.
3. In the “Programs and Features” group, click “Turn Windows Features On or Off”.
4. When you are prompted to allow the application to run, click “Continue”.
5. In the “Windows Features” dialog box, expand
   a. Information Services
   ➢ Web Management Tools >
     1. IIS 6 Management Compatibility.
     2. Select the “IIS Metabase and IIS 6 Configuration Compatibility” check box.
6. Expand “Internet Information Services”
   ➢ “World Wide Web Services”
   ➢ “Application Development Features”.
   ➢ Select the “ASP.NET” check box. Three other settings will also be automatically selected:

7. .NET Extensibility,
8. ISAPI Extensions,
9. ISAPI Filters.
10. Expand “Internet Information Services”
    ➢ “World Wide Web Services”
    ➢ Select the “Common HTTP Features” check box.


12. Click OK.

User Account Control
If you plan to schedule automatic backups using ADMS Console, the User Account Control settings in Windows Vista must be configured to allow applications to run without prompting for administrator permission. **Note:** Configuring the following settings will affect all of the applications on your computer. All applications will be run without prompting for administrator approval.

1. From the Windows Vista Start menu, type “run”.
2. In the Run dialog box, enter “secpol.msc”. Click OK.
3. When you are prompted to allow the security policy application to run, click Continue.
4. In the “Local Security Policy” dialog box, expand:-
   a. “Security Settings”
      ➢ “Local Policies”
      ➢ “Security Options”.

5. Locate the “User Account Control: Behavior of the Elevation Prompt for Administrators” policy and right-click it.
   a. Click Properties.
      ➢ Select “Elevate without Prompting”, and then click OK.

6. Locate the “User Account Control: Run All Administrators in Admin Approval Mode” policy and right-click it.
   a. Click Properties.

7. Select “Disable”, and then click OK
Configuring automatic backups with Microsoft Vista™

To configure automatic backups in Microsoft Vista™ perform the following steps:

1. Open the Task Scheduler in the Administrative Tools of the Control Panel.
2. Create a Basic Task and fill in the necessary information in the dialog box and select the batch file you created for the backup.
3. When you get to the Summary dialog, check the box next to Open the Properties dialog for this task when I click Finish.
4. In the General tab of the task you just created, select the radio button next to Run whether user is logged on or not.
5. Check the box next to Run with highest privileges.

The following is an example of a backup script you can use for a local SQL Server.

```bash
@ECHO OFF
REM PROVIDING THE BEST RESULTS FOR BACKING UP THE VAULT
REM DELETE B AND CASCADE A BACKUP SUBDIRECTORIES
RMDIR /Q /S "C:\Backup\Vault\B"
REN C:\Backup\Vault\A B
REM CREATE A NEW DIRECTORY FOR THE BACKUP
MKDIR "C:\Backup\Vault\A"
REM START THE BACKUP PROCESS (THIS IS ONE LINE OF TEXT)
"C:\Program Files\Autodesk\Data Management Server 2008\AUTODESK DATA MANAGEMENT SERVER Console\Connectivity.AUTODESK DATA MANAGEMENT SERVER\Console.exe" –Obackup -B"C:\Backup\Vault\A" -VAdministrator –VP<password> -S
NET STOP MSSQL$AUTODESKVAULT
NET START MSSQL$AUTODESKVAULT
```

**Note:** Unlike previous versions of Autodesk data management server, you no longer need to stop the web services before you perform a backup. You can also use the –DBSC switch in the Autodesk data management server Console line to exclude the standard content libraries from being backed up during this process.
Setting up a remote backup location

If you plan to back up your vault data to a remote share, follow the steps in the Creating a new domain user account, Create a remote share and Setting the new account in the Autodesk data management server Console sections in this document. After that is complete, you will have to modify the SQL Service to use a domain account using the following steps:

Note: The new domain account created for these steps needs to be added to the default SQL users group for the AutodeskVault instance. The group created by SQL 2005 is called SQLServer2005MSSQLUser$<computername>$AUTODESKVAULT.

1. Double-click the Services icon in the Administrative Tools in the Control Panel
2. Double-click on the SQL Server (Autodeskvault) service and select the Log On tab.
3. Select the This Account radio button and enter a domain account in the form of Domain_Name\Domain_account (with the correct password).

   NOTE: If you change the service’s login credentials, you will be prompted to restart the MS SQL Server service. Please do so for changes to take effect. In addition, ensure that clients are not using the Autodesk data management server before restarting SQL Server.”
4. Verify that the account specified has write access on the share to which you are backing up.
Configuring a remote Vault / Productstream connection using FQDN

To configure the Vault Server or Productstream™ server to allow remote connections over the internet using a Fully Qualified Domain Name (FQDN): **Not supported if using AWS**

1. Create a DNS "A" or host record for your current FQDN with your ISP.
2. Install Autodesk data management server on your server and verify that it works properly.
3. On your server, open the Internet Information Services Manager and expand the Websites folder.
4. Right-click on the website that contains the AutodeskDM virtual directory. Click Properties.
5. In the Properties dialog box, click the Website tab.
6. On the Website tab, click Advanced.
7. In the Advanced Website Identification dialog box, under the Multiple identities for the website, click Add.
8. In the Add/Edit Web Site Identification dialog box, select the correct IP address that will interact with the website.
9. Enter the TCP port you want to use. If this is not port 80, then your clients will have to add ":<port#>" at the end of the FQDN in order for the connection to work.
10. In the Host Header value, enter the FQDN.
11. Click OK to close each dialog box.

Note: Additional settings may be required for your router or firewall. Check with your IT department for the necessary changes.

How to increase the timeout values on the Autodesk data management server

As the vault database increases in size, you may have to modify some timeout values on the server to allow for the server to process more data. Increase the timeout values for client and server functions:

1. Open Windows Explorer and navigate to the C:\Program Files\Autodesk\Data Management Server 2009 (ADMS 2010)\Server\Web\Services directory.
2. Create a backup copy of the Web.config file.
3. Open the Web.config file with Notepad and look for the following line:
   ```
   <timeouts connection="15" defaultCommand="360" longCommand="1800" />
   ```

   Note: these values may be different, depending on the size of the vault and the speed of the server it is installed on. Higher values may be necessary.
5. Open a command prompt and type IISRESET.

Note: If you increase the defaultCommand value higher then 1000, you must increase the executionTimeout value to an equal or higher value. This is found on the following line:
   ```
   <httpRuntime maxRequestLength="51200" executionTimeout="1000" />
   ```
Running Autodesk data management server with SSL

Setting up the Autodesk data management server to use SSL (Secure Socket Layer) is a two step process.

1. On the DM Server machine, install the certificate and setup the website SSL preferences.
2. Verify that the clients can communicate properly with SSL.

Configuring the DM Server machine

It is outside of the scope of this document to instruct you how to setup SSL under IIS. For more information, visit the following web resources. Note that some steps may be different depending upon the version of Windows that you are currently using.

  
  * When creating the certificate, you will need to specify the Common Name for your web site. If your Vault will be accessible from the Internet, use the FQDN (Fully Qualified Domain Name) as the common name (ex. vault.abccorp.com). If you are connecting internally only, you can use the computer name of the DM server as the common name.


By default, the Autodesk data management server installer does not configure the AutodeskDM Virtual Directory to require SSL. After the certificate has been installed on the Default Web Site, users are able to login to the Autodesk data management server using both secured and unsecured connections.

Unsecured logins can be accomplished by using localhost, 127.0.0.1, machine name or IP address in the server field of the login dialog.

Secured logins must use the common name to which the certificate was issued.

If Productstream Explorer (Webclient) is installed on the server, clients will need to access it from their web browser with https://servername/AutodeskDM/Webclient.
Configure the AutodeskDM Virtual Directory to require SSL Access

NOTE: The following procedure uses the Internet Information Services Manager to configure the AutodeskDM Virtual Directory to require SSL for access.

1. Log into the computer hosting the Data Management Server as a local or domain administrator.
2. From the Start Menu, select Settings > Control Panel.
3. Double-click Administrative Tools, and then double click Internet Information Services.
4. Click Web Sites under your server name.
5. Select the Default Web Site and expand it. This web site must have the certificate you created installed to it.
6. Right-click the AutodeskDM virtual directory and click Properties.
8. Click Edit under Secure Communications.

   NOTE: If the View Certificate button is unavailable, the certificate that you created has not been installed on the AutodeskDM Virtual Directory’s parent web site. Install a certificate before continuing with the rest of this process.

9. Click Require secure channel (SSL). Clients browsing to this directory must now use HTTPS.
10. Click OK.
11. Click OK.
12. If the Inheritance Overrides dialog is displayed, click Select All and then click OK. The new security settings are applied to all subdirectories of the AutodeskDM virtual directory.
13. Close the Internet Information Services Console.

Configure IIS 7.0 with an SSL Certificate.

Configure the Server.

NOTE: The following procedure uses the Internet Information Services (IIS) Manager to configure IIS7 to require SSL for access.

1. Log into the computer hosting the Data Management Server as a local or domain administrator.
2. From the Start Menu, select Control Panel.
3. Double-click the Administrative Tools, then double click the Internet Information Services (IIS) Manager.
4. Select the IIS server listed on the left hand pane, then double-click **Server Certificates**.

5. If you already have a certificate from a Certificate Authority, you can **Import** your certificate by using the **Actions** pane on the right hand side of the **Server Certificates** window. You can also create a **Self-Signed Certificate** from the **Actions** pane.

   NOTE: The remainder of this document outlines using a Self-Signed Certificate named **AutodeskDM**.

6. Select **Create Self-Signed Certificate**. Name the certificate **AutodeskDM**, click **OK**.

7. Expand the **Sites** tree and select the website that is hosting the AutodeskDM virtual Directory. In the image below, the website is **Default Web Site**. Select **Default Web Site** and click **Bindings** from the **Actions** pane.

8. Click **Add** and change the type to **https** and change the SSL Certificate to **AutodeskDM** (or your imported certificate.) Click **OK**
9. If you wish to restrict all non SSL vault communication, click the http binding and select remove.
10. Close the Internet Information Services (IIS) Manager.

Configuring Client Machines

To verify that the SSL client/server communication is properly setup, open Internet Explorer and browse to https://<servername>. If the connection is not working, the Security Alert dialog box is displayed.

Follow the solutions below if the Security Alert dialog box contains one or more of the following warnings:

1. The certificate is not from a trusted authority.
2. The date on the certificate is invalid.
3. The name on the certificate does not match the name of the site.

Solution 1 - Add the CA root certificate to the Trusted Root Certification Authority store on the client machine

1. Open an Internet Explorer window and browse to the https://machineName.
2. In the Security Alert dialog box, click View Certificate.

3. The Certificate dialog box describes the alert. If you trust this source, click Install Certificate to launch the Certificate Import Wizard.
4. In the Certificate Import Wizard, click Next. Click **Place all certificates in the following store** and then click Browse and locate the Trusted Root Certification Authorities node.

5. Click Next and then Finish.

6. A dialog box is displayed indicating the certificate is successfully imported. Click OK.

7. Open Internet Explorer and go to Tools > Internet Options > Content tab.
8. Click Certificates.

9. Select the Trusted Root Certification Authority tab and then locate the certificate issued to the server. If it is present, click Close.
Solution 2 - Check the expiration date of the certificate

1. In the Security Alert dialog box, click View Certificate.

2. If the **Valid from** date range has expired or is not valid yet, contact your IT department and notify the Web Server Administrator that the certificate has expired and a new certificate request and installation from the Certificate Authorities are needed.

Solution 3 - Verify the certificate name matches the name of the site

1. Ask your Web Server Administrator for the exact certificate name issued for the DM Server. Try the newly provided name again using [https://newServerName](https://newServerName) and if that does not raise the Security Alert message box, then use the new name in the VE client application’s login dialog when logging in securely to the DM Server.

When you have ensured that client web service requests/responses have clear passage to and from the server, you can log in from a client application using SSL.
Configuring a Client Computer with Internet Explorer 7

To verify that the SSL client/server communication is properly setup, open Internet Explorer and browse to https://<servername>. If the connection is not working, the Security Alert dialog box is displayed.

There is a problem with this website's security certificate.

The security certificate presented by this website was not issued by a trusted certificate authority.

Security certificate problems may indicate an attempt to fool you or intercept any data you send to the server.

We recommend that you close this webpage and do not continue to this website.

1. Click Continue to this website (not recommended).
2. Click the Certificate Error message next to the Address bar and choose View Certificates.
3. Click Install Certificate.
4. Follow the **Certificate Import Wizard** and **Place** the certificate in the **Trusted Root Certification Authorities**.

5. Allow the certificate to finish loading by selecting **Yes** at the following prompt, if asked.

```
Security Warning

You are about to install a certificate from a certification authority (CA) claiming to represent:

NOV12358533

Windows cannot validate that the certificate is actually from "NOV12358533". You should confirm its origin by contacting "NOV12358533". The following number will assist you in this process:

Thumbprint (sha1): 62125400 D237C82A 3FF14F65 EFE50B8A BE733D60

Warning:
If you install this root certificate, Windows will automatically trust any certificate issued by this CA. Installing a certificate with an unconfirmed thumbprint is a security risk. If you click "Yes" you acknowledge this risk.

Do you want to install this certificate?
```

**Login from client applications using SSL**

1. In the Log in dialog box, enter your user name, password, and the name of the database.
2. For the name of the server, specify the machine name of the server with the prefix: https://. For example:
   - If you are using the default SSL port 443: https:// ServerName
   - If you are using a different SSL port: https://ServerName:XXX where XXX is the SSL communication port number.

   **NOTE:** The secured login depends on the certificate issued to the server machine. If it is issued for the machine name, then only https://ServerName will work. Otherwise, if the certificate is issued for a dedicated IP, then only https://serverIPAddress will work as a secure vault login.
Using Vault with a Proxy Server

This section describes setting up a proxy to enable successful Autodesk Client/Server data communication.

If a client machine connects to the web server through a proxy server, then all calls to the Autodesk data management server from any Autodesk client will fail. To have a successful Autodesk Client/Server communication, you need to bypass the proxy server.

Change the proxy settings in Internet Explorer 6.x, 7.x

1. Open Internet Explorer.
2. From the Tools menu, select Internet Options.
3. Select the Connections tab.
4. Click LAN Settings.
5. If the “Use a proxy server for your LAN” check box is enabled, turn on the “Bypass proxy server for local addresses” check box.
6. Click the Advanced button next to the Port field.
7. In the Proxy Setting dialog, add the server name and IP address into the Exceptions field.
8. Click OK.
9. Click OK.
10. Click OK to close Internet Options.

All addresses without a period, for example: http://webserver, will bypass the proxy and be resolved directly.

If Internet Explorer continues to connect to the assigned HTTP proxy server, then the HTTP proxy address may contain a period. If this happens, configure the proxy server to use a host name.

Configure the proxy server to use a host name

1. Follow steps 1-5 above for changing the proxy settings in Internet Explorer.
2. If the “Address” field is “http://webserver.domainname.com” or “http://10.0.0.1”, then change it to “http://webserver” only.
3. Click OK and close Internet Explorer Options.

For more information on advanced proxy bypass configurations:

- Read Microsoft Knowledge Base article 262981: "Internet Explorer Uses Proxy Server for Local IP Address Even if the ‘Bypass Proxy Server for Local Addresses’ Option Is Turned On"

**Bypassing a Proxy Server with the Application config file**

By default HttpWebRequest's uses the proxy setting specified inside of Internet Explorer. You can change those settings by going to Control Panel -> Internet Options -> Connections Tab -> LAN Settings Button. You can disable auto detection by un-checking the "Automatically Detect Settings" button. In most cases this allows the client application to function properly. However, in some cases you may experience slow connectivity and delayed responses from the application when connected to Autodesk data management server. There is an option to disable proxy configuration through your application.exe.config file:

In this example, for Inventor, the config file is located in the following directory. Each client application has a similar config file. Make a backup copy of the file and then edit the file using Notepad.exe ONLY.

"C:\Program Files\Autodesk\Inventor 2009\Bin\Inventor.exe.config"

Add this line of code to the file:

```
<system.net>
  <defaultProxy >
    <proxy autoDetect="False"/>
  </defaultProxy>
</system.net>
```

After you have added the text, save and close the file. The changes will take effect the next time the application is started.
Autodesk data management server Log Files

This section shows you where to find the various log files and other files used for troubleshooting potential problems with Autodesk Vault or Autodesk Productstream.

For the purposes of this section, we refer to the %temp% folder. This is the temp folder location defined for the Windows user account that is logged in on the computer. By default, this folder is located in the following location:

C:\Documents and Settings\ACCOUNTNAME\Local Settings\Temp

In this example, ACCOUNTNAME is the name of your user account in Windows.

Autodesk data management server 2009 / 2010 installation log files

During the installation of Autodesk data management server there may be errors reported by the diagnostic tool or during the installation itself. These errors are recorded in log files.

Pre-check log:
%temp%\EDMlog
Prechecks.xml
Prechecks.xsl

Autodesk Productstream 2009 client installation logs:
%temp%
Autodesk Productstream 2009 Install.log
Autodesk Productstream 2009 Setup.log

Autodesk Vault 2009 client installation logs:
%temp%
Autodesk Vault 2009 Install.log
Autodesk Vault 2009 Setup.log

Autodesk data management server 2009 installation logs:
%temp%
Autodesk data management server 2009 (Vault or Productstream).log

Productstream Explorer installation logs:
%temp%
Autodesk Data Management Server 2009 (Productstream) Setup.log
Autodesk Productstream 2009 (Server) Install.log

Autodesk Vault <Version> 2010 client installation logs:
%temp%
Autodesk Vault <Version> 2010 Install.log
Autodesk Vault <Version> 2010 Setup.log

Autodesk Vault <Version> 2010 server installation logs:
%temp%
Autodesk Vault <Version> 2010 (Server) Install.log
Autodesk Vault <Version> 2010 (Server) Setup.log
Autodesk Server Diagnostic Tool Log files

If you run the Autodesk Server Diagnostic Tool, the log files are located in the %temp%\EDMLog directory.

Autodesk Server Diagnostic Tool:

%temp%\EDMLog
DiagTool.xml
DiagToolLog.xsl

Vault server log files

There are primarily two different log files to look for in this location. Each of these is described in full detail below.

Folder location and file names:

Microsoft Windows™ XP - C:\Documents and Settings\All Users\Application Data\Autodesk\VaultServer\FileStore
Microsoft Server 2003 - C:\Documents and Settings\All Users\Application Data\Autodesk\VaultServer\FileStore
Microsoft Vista™ - C:\ProgramData\Autodesk\VaultServer\Filestore
Microsoft Windows Server 2008 - C:\ProgramData\Autodesk\VaultServer\Filestore

Vlog-YYYYMMDD.txt

Any server-side problems relevant to Check-in, Check-out, Get Latest Version, Undo Check-out, Advanced Search and other operations performed from within Vault Explorer or one of the supported product add-ins are written into these log files.

ADMSConsoleLog-YYYYMMDD.txt

Any server-side problems relevant to backup, restore, re-index, purge or other operations performed within Autodesk data management server Console are written into these logs.

Emaillog-YYYYMMDD.txt

Email sent from the server for Productstream 2009 and Vault Manufacturing 2010 notifications.

Microsoft SQL Server log files

Folder location and file names:

C:\Program Files\Microsoft SQL Server\%SQL_INSTANCE%\LOG

Errorlog
Errorlog.1
Errorlog.2
Errorlog.3
The SQL logs are named sequentially with the most recent (current) file being named errorlog followed by errorlog.1 then errorlog.2 and so on.

**DWG and DWF iFilter Log files**

There are log files maintained by the various iFilters used when performing some Vault operations like re-index. These log files can be helpful when troubleshooting problems with block attributes or properties not indexing as expected in Vault Explorer.

Folder location and file names:

Depending on your server setup, your iFilter log files may be contained in a different location.

C:\Windows\Temp\DWFFILTER.*.log
DWGFILT.*.log
INVFILTER.*.log

**Indexing Block Attributes (DWG files)**

When troubleshooting problems with DWG block attributes not indexing in a vault, you'll also want to find the FilterConfig.xml. This file is created when you index block attributes in the Autodesk data management server Console and is found in the following location:

Folder location and file name:

C:\Program Files\Autodesk\Data Management Server 2009 (ADMS 2010)\Server\Web\Services\FilterConfig.xml
Customize W3C Extended Logging

“The W3C Extended log file format is the default log file format for IIS. It is a customizable ASCII text-based format. You can use IIS Manager to select which fields to include in the log file.” [W3C Extended Log File Format]

1. From the Windows Start menu, select Control Panel > Administrative Tools > Internet Information Services

2. In IIS Manager, expand the local computer, expand the Web Sites folder, right-click the Default Web site, and click Properties.

3. On the Web Site tab, select the Enable logging check box (if it is not already selected).
4. In the Active log format drop-down list, select W3C Extended Log File Format and click the Properties button.

(BEFORE)

NOTE: Before changing the extended properties, write down or take snapshots (Alt+PrintScrnn) of currently selected W3C properties in case of wanting to go back to the original state in the future.

5. On the Advanced tab (for Windows 2003 server) or Extended Properties tab (for Windows XP), select logging ALL properties.

(AFTER)

6. Click OK and close IIS Manager.
7. From the Windows Start menu, select Run. Type: iisreset and then click OK to restart IIS.

8. IIS logs are located in the following directories:
   a. C:\WINDOWS\system32\LogFiles\W3SVC1 – for the Default Web site communication.
   b. C:\WINDOWS\system32\LogFiles\HTTPERR – for IIS errors logs.
Productstream 2009 / Vault Manufacturing 2010 Replication

This section addresses topics specifically related to the unique environments associated with replicating data to multiple work sites.

Scalability of Replication

Replication uses a single database for all sites and replicates the file store to each location. This architecture has distinct advantages in ease of implementation, end user experience and the instantaneous nature of the information availability. This architecture is not suited to multiple sites that are distributed over great distances or poor networks. It is recommended that the replication environments are not distributed across multiple continents.

If you are unsure of the appropriateness of Replication in your environment you can easily estimate the performance. The performance can be gauged between two remote sites by browsing a network share between the sites. If the responsiveness of the remote share is deemed acceptable for daily access Replication will also be acceptable. Productstream and Vault communicate via http which is more efficient than the default windows system which is observed when browsing a remote share.
Content Center in a Replicated Environment

Introduction

Autodesk Inventor Standard Content is delivered in the form of library databases that are hosted by the Autodesk data management server. Users access these library databases through Inventor to automatically create selected library components as Inventor part files. Once instanced these components are stored in a folder defined by the Inventor project file. When the assembly is then checked into Vault, the instanced Content components are also checked into Vault.

In a Replicated Autodesk Vault or Productstream environment we can tune the performance of Content Center by altering the configuration of the Inventor project file.

Assumptions

The following examples assume all software including the Content has been installed. These examples also assume the reader has a functional understanding of how Content is instantiated and referenced. If required please reference the Content Center help files.

The diagrams below show the SQL server as a separate computer for clarity. SQL Server may be on a separate computer or on the Autodesk data management server, either case is supported and has no impact on the workflows detailed in this document.

Private Content Center Folder

The default configuration when using Inventor is for each client to have a private Content folder.

Advantages:

- Suitable for assemblies that have a high volume of Content components by eliminating network traffic for existing local components.
- Allows each user to have only the content they use in their Private Content Folder.

Disadvantages:

- Consumes considerable disk space on the client
- Each client must instantiate each referenced component in their Private Content Folder
Private Content Example

1. Client 1 creates an instance of a component from the Content Center database. The instanced part file is written to the Private Content Center folder located on the client computer.

2. User checks in the instanced component as part of an assembly. The Content part is copied into the Vault file store.
   
   Note: Keeping the part file in the local folder will remove the delays, for this user, due to instancing the part file or copying it from the file store.

3. Client 2 inserts the same component that Client 1 used. Since the part does not yet exist in the Private Content Center Folder for Client 2 it must be instanced from the database.

4. Once instanced the assembly may be checked into Vault. Vault knows that this component already exists and will resolve the assembly with the existing component in the file store.

5. During the scheduled replication at each Autodesk data management server the Content components will be copied to the local file store at each site.

6. Client 3 inserts the same component that Client 1 & 2 have previously used. The component must be instanced from the remote database. This is the same process as Client 2 in step 3 but the instantiation delay may be increased based upon the distance and network latency between the client and the SQL Server.
Seeding the Content Center Folders

The re-instancing of existing components can be avoided by performing a ‘Get Entire Folder…’ from Vault Explorer or Productstream. This will seed the Content Center Folder with all instanced Content that has been checked into the Vault. This applies to both the Private and Shared Content Center Folders. In environments where new content is created frequently it may be advantageous to perform this operation on regular basis.
## Revision History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Comments</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>Initial Release</td>
<td>4/17/2009</td>
</tr>
<tr>
<td>1.1</td>
<td>Revised screenshots and verbiage under IIS 7.0</td>
<td>4/29/2009</td>
</tr>
</tbody>
</table>